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INTRODUCTION 
Information about METTLER TOLEDO Technical Training for North 
America can be obtained by writing, calling, or faxing: 

 METTLER TOLEDO 
 1900 Polaris Parkway 
 Columbus, Ohio 43240  USA 
 Phone: (614) 438-4511 
 Fax: (614) 438-4958 
 www.mt.com 

Outside of North America, contact your local supplier. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

METTLER TOLEDO RESERVES THE RIGHT TO MAKE 
REFINEMENTS OR CHANGES WITHOUT NOTICE. 

 



 

Mettler-Toledo, Inc. 
(hereinafter Mettler-Toledo) 

 
END-USER LICENSE AGREEMENT FOR 

METTLER TOLEDO OverDrive® SOFTWARE 
 
IMPORTANT–READ CAREFULLY: Mettler-Toledo's End-User License Agreement ("EULA") is 
a legal agreement between you (either an individual or a legal entity) and Mettler-Toledo 
for the proprietary OverDrive® Software identified above, which includes computer 
software and may include associated media, printed materials, and "online" or electronic 
documentation ("OverDrive® Software"). This OverDrive® Software is made available to 
you only on the terms and conditions of this EULA. By installing, copying, or otherwise 
using the OverDrive® Software (whichever occurs first), you agree to be bound by the 
terms of this EULA. If you do not agree with the terms of this EULA, you are not authorized 
to use the OverDrive® Software. 

 
OverDrive® SOFTWARE LICENSE 
 
The OverDrive® Software is protected by copyright laws and international copyright 
treaties, as well as other intellectual property laws and treaties. The OverDrive® Software 
is licensed, not sold. 
 
1. GRANT OF LICENSE 

Installation and Use. This EULA grants to you the non-exclusive and non-transferable right 
to use the OverDrive® Software for your own internal purposes only. You may install and 
use one copy of the OverDrive® Software on a single terminal connected to a single 
computer (i.e., with one CPU). You may either make copies of the OverDrive® Software 
solely for archival purposes in support of your use of the OverDrive® Software on a single 
computer or transfer the OverDrive® Software to a single hard disk provided that you keep 
the original only for backup or archival purposes. You may not reproduce or distribute the 
software in any other way, including rental or leasing. 
 
2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS 

Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not 
reverse engineer, decompile, or disassemble the OverDrive® Software, except and only to 
the extent that such activity is expressly permitted by applicable law notwithstanding this 
limitation. 

Separation of Components. The OverDrive® Software is licensed as a single product. Its 
component parts may not be separated for use on more than one computer. 

Support Services. Mettler-Toledo may provide you with support services related to the 
OverDrive® Software ("Support Services"). Use of Support Services is governed by Mettler-
Toledo's policies and programs described in the user manual, in "online" documentation, 
and/or in other Mettler-Toledo-provided materials. Any supplemental software code 
provided to you as part of the Support Services shall be considered part of the OverDrive® 
Software and subject to the terms and conditions of this EULA. With respect to technical 
information you provide to Mettler-Toledo as part of the Support Services, Mettler-Toledo 
may use such information for its business purposes, including for product support and 

 



development. Mettler-Toledo will not divulge such technical information to third parties 
allowing personal identification. 

Software Transfer. You may not transfer any of your rights under this EULA. 

Termination. Without prejudice to any other rights, Mettler-Toledo may terminate this EULA 
if you fail to comply with the terms and conditions of this EULA. In such event, you may 
not use the OverDrive® Software any longer and you must destroy all copies of the 
OverDrive® Software and all of its component parts. 
 
3. COPYRIGHT 

All title and copyrights in and to the OverDrive® Software (including but not limited to any 
images, photographs, animations, video, audio, music, text, and "applets" incorporated 
into the OverDrive® Software), the accompanying printed materials, and any copies of the 
OverDrive® Software are owned by Mettler-Toledo or its suppliers. The OverDrive® 
Software is protected by copyright laws and international treaty provisions. Therefore, you 
must treat the OverDrive® Software like any other copyright protected material. 
 
4. WARRANTIES 

The OverDrive® Software and any related documentation is provided to you "as is". 

Limited Warranty. Mettler-Toledo undertakes at your written request within 90 days at the 
sole discretion of Mettler-Toledo to repair or replace any part of the OverDrive® Software 
which is defective or unusable as a result of poor materials, faulty design or incorrect 
manufacture. 

No other warranties. Mettler-Toledo expressly disclaims any further warranty for the 
OverDrive® Software including warranty of any kind, whether express or implied, 
including, without limitation, the implied warranties of merchantability, fitness for a 
particular purpose, or non-infringement. The entire risk arising out of use or performance 
of the OverDrive® Software remains with you. 

No liability for damages. In no event shall Mettler-Toledo or its suppliers be liable for any 
damages whatsoever (including, without limitation, damages for loss of business profits, 
business interruption, loss of business information, or any other pecuniary loss) arising 
out of the use of or inability to use this OverDrive® Software, even if Mettler-Toledo has 
been advised of the possibility of such damages. Because, however, some 
states/jurisdictions do not allow the exclusion or limitation of liability for consequential or 
incidental damages by compulsory law, the above limitation may not apply to you. 
 
5. MISCELLANEOUS 

This EULA is governed by the laws of the State of Ohio. Any dispute arising out of or in 
connection with this EULA shall be subject to the exclusive jurisdiction of the courts of the 
State of Ohio. Notwithstanding the foregoing, Mettler-Toledo retains the right to bring legal 
action against you before any other competent court. 

Should you have any questions concerning this EULA, or if you desire to contact Mettler-
Toledo for any reason, please contact: Mettler-Toledo, Inc., 1900 Polaris Parkway, 
Columbus, Ohio, USA 43240. 
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1   Installing the Program 
 

 

Introduction 
An OverDrive unattended driver terminal enables drivers to process 
their own vehicle weighing transactions without having a scale 
operator on duty. OverDrive unattended software is designed to 
configure unattended driver terminals so that they can be used with 
the OverDrive vehicle scale software system. Before you can use 
OverDrive unattended software, you will need to install OverDrive 
software (version 2.3.0 or later) and the SQL Server 2005 database 
(which requires Microsoft .NET Framework 2.0). 

This manual explains how to install OverDrive unattended software 
modules and use them with unattended driver terminals. For 
information about installing an unattended driver terminal or other 
equipment, refer to the manual for the specific type of equipment. 

 

 

Requirements 
Install OverDrive software on a personal computer with the following 
capabilities: 

• Intel 2 GHz or higher (recommended). 

• Microsoft XP Professional SP2 plus current Windows updates 
(required). 

• Minimum 2 GB of RAM (recommended). 

• Minimum 10 GB free HDD (recommended). 

• Video Driver Support for 32-bit color; minimum 1024 x 768 
screen resolution is required (1152 x 864 is recommended). 

• Internet Explorer 6 or higher (required). 

• DVD ROM drive (required). 

• Operating User ID – Standard User (Power User Group) 
Permission (required); Installation – Administrator (required). 

• Keyboard (required). 

• Mouse (required). 

• 100 MBS or higher network adapter (required). 
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Installation 
The following instructions explain how to install OverDrive 
unattended software. The setup wizard installs software for the 
Unattended and Credit Card Modules. There is a separate wizard for 
installing the Video Server Module. 

1. Place the OverDrive installation disk in the computer’s disk 
drive. To start the setup wizard, run the OverDrive setup.exe file 
located in the OUDT Support/OUDT Install folders on the disk. 

 

 
 

2. Click the Next button to start the setup procedure. 
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3. The Folder data field shows the default location of the 
OverDrive software. If the software was installed in a different 
location, enter that location. Then click the Next button. 

 

 
 

4. Select the version of SQL Server that was installed (2000 or 
2005). Then click the Next button. 
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5. The default location for the OverDrive unattended files is 
C:\Program Files\Mettler Toledo\OverDrive OUDT. Use the 
Browse button if you want to select a different location. Then 
click the Next button. Clicking the Disk Cost button shows the 
amount of disk space required for the installation. The radio 
buttons determine whether a Start menu shortcut is created for 
everyone or the person who is logged in during installation. 
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6. Click the Next button to begin installing the software. 

 

 
 

7. The wizard will show the progress of the installation process. 
Wait for the Installation Complete window to appear. 

 

 
 

8. The installation has been completed. Click the Close button to 
close the wizard. 
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Modification 
Once the program has been installed, you can use the setup wizard 
to repair or remove system components. 

 

Repair 
You will need the OverDrive installation disk to repair the system. 
Place the disk in the computer’s disk drive. To start the setup 
wizard, run the OverDrive setup.exe file located in the OUDT 
Support/OUDT Install folders on the disk. 

 

 
 

1. Select a modification option, and then click the Finish button. 

• Repair lets you repair your system by replacing the 
components that were selected during the previous 
installation. 

• Remove lets you remove all components that are 
currently installed. 
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2. The wizard will show the progress of the modification 
procedure. Wait for the Installation Complete window to 
appear. 

 

 
 

3. The procedure has been completed. Click the Close button to 
close the wizard. 
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Remove 
You can remove OverDrive unattended software without using the 
installation disk. 

 

 
 

1. Click the Start button in the lower left-hand corner of the 
computer screen. Then select Control Panel from the Start 
menu. 
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2. Double-click the Add or Remove Programs icon in the control 
panel. 

 

 
 

3. Select the OverDrive unattended software from the list box, 
and then click the Remove button. 
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4. Click the Yes button to remove the software. 

 

 
 

5. A status window will show the progress of the removal 
procedure. When the window closes, the procedure has been 
completed. 
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Video Server 
Installation 

Install the video server only if you plan to register it. You must install 
OverDrive unattended software before installing the video server. We 
recommend installing the video server on a separate computer from 
the OverDrive software application because processing video uses a 
lot of the computer’s resources. The following instructions explain 
how to install the OverDrive video server. 

1. Place the OverDrive installation disk in the computer’s disk 
drive. To start the setup wizard, run the setup.exe file located in 
the OUDT Support/ODVS Install folders on the disk. 

 

 
 

2. Click the Next button to start the setup procedure. 
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3. Enter the name of the computer where the OverDrive software is 
installed and the TCP/IP port used to communicate with that 
computer. Then click the Next button. 

 

 
 

4. The default location for the OverDrive video server is 
C:\Program Files\Mettler Toledo\OverDrive Video Server. Use the 
Browse button if you want to select a different location. Then 
click the Next button. Clicking the Disk Cost button shows the 
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amount of disk space required for the installation. The radio 
buttons determine whether a Start menu shortcut is created for 
everyone or the person who is logged in during installation. 

 

 
 

5. Click the Next button to begin installing the software. 

 

 
 

6. The wizard will show the progress of the installation process. 
Wait for the Installation Complete window to appear. 
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7. The installation has been completed. Click the Close button to 
close the wizard. 
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Registering 
After you have installed OverDrive software, you will need to register 
it. Until the software is registered, you can use it in demonstration 
mode for 14 days. At the end of the 14-day demonstration period, 
the program will shut down if it has not been registered. 

If OverDrive software was registered for use with an add-on module, 
then there is no need to register again when you install that module. 
If you are installing an add-on module that was not selected when 
you registered OverDrive software, then use the following procedure 
to register the module. 

Register your installation from the Registration screen. To open the 
screen, click the OverDrive OUDT icon in the Start / All Programs / 
Mettler Toledo menu. 

 

 
 

1. In the list box, place a check mark next to the software 
modules that you have purchased. If you do not check any 
boxes, you will be registered for the basic software package. 
Contact your local Mettler Toledo customer service 
representative to get the registration keys for your software. You 
will need to provide the two product codes listed on the 
Registration screen. 

2. Mettler Toledo will provide the registration keys for your system. 
Enter those keys in the Registration Keys data fields on the 
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Registration screen (enter key #1 in the first field and key #2 in 
the second field). 

3. Click the Register button. You will then be prompted to restart 
the application in order to complete the registration process. 

After you have registered your software, the Registration screen will 
no longer open automatically when you log in to the system. To 
display the Registration screen, start the program and select 
Register in the Help menu. 

 

Registration 
Screen 

Product Codes 
The product codes listed in the two data fields on the Registration 
screen are for the computer on which the software is installed. The 
registration keys that you receive will be linked to those product 
codes. To register a system, you must enter the registration keys 
that are linked to the product codes shown on the screen. 

Registration Keys 
There are two Registration Keys data fields. When you receive your 
registration keys, enter them in the data fields in order to register 
your system. 

Push Buttons 

 
Demo: Click the Demo button to start the program in demonstration 
mode. Demo mode allows you to try out the software, giving you 
access to all functions and all available languages. At the end of the 
14-day demonstration period, the program will shut down if it has 
not been registered. 

 
Register: Click the Register button to register your system. You will 
need to obtain registration keys and enter them in order to register. 
When you have entered registration keys and clicked the button, you 
will be prompted to restart the application in order to complete the 
registration process. 

 
Cancel: Click the Cancel button to delete any changes and close the 
Registration screen. 
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3   Startup 
 

 

How to Start 
the Program 

When OverDrive unattended software is installed, an OverDrive 
OUDT icon will be created in the computer’s Start / All Programs / 
Mettler Toledo menu. 

1. Select the OverDrive OUDT icon and press the ENTER key (or 
double-click on it). The OverDrive Login screen will open. 

 

 
 
2. Type your user name in the User Name field. 

3. Move the cursor to the Password field and type your 
password. The password will not be shown in the field; each 
character will appear as an asterisk. 

4. Click the OK button or press the ENTER key to start the 
program (click the Cancel button to exit). 

If you typed your user name and password correctly, the main 
OverDrive screen (shown below) will open. 
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This screen provides access to all OverDrive unattended screens, 
tables, and functions. The rest of this chapter describes the basic 
features of the screen and how to use them. 

The user who is currently logged in is listed on the status bar in the 
lower left-hand corner of the screen. 

 

 
 

You can change users without shutting down the program. Click on 
Current User on the status bar to open the OverDrive Login screen, 
which will allow a new user to log in. When a new user logs in, the 
previous user is automatically logged out. When this feature is used, 
only the main OverDrive screen can be open. All other screens must 
be closed. 
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Menu Bar 
The menu bar at the top of the screen provides the following menus: 

 

 
 

File Menu 
• Exit: This item closes the program. 

View Menu 
• Status Bar: This item opens and closes the status bar at the 

bottom of the main OverDrive screen. 

• Locale: This item lets you select a language and country for the 
software. Open the View menu, position the cursor over the 
Locale item to display a list of languages, position the cursor 
over the desired language to display a list of countries, and 
then click on the desired country to select it. 

 

 
 

Data Setup Menu 
• Images: This item opens the video server’s Isolated Images 

screen and Transaction Images screen. 

Tools Menu 
The tools in this menu are described in Chapters 4 and 5. 

• Options: This item is for future use. 

• Application Settings: This item opens the Application Settings 
screen, which is used to display database information, assign 
function keys on the unattended driver terminal, and set time 
intervals for the terminal. 
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• Badge Assignment: This item opens the Badge Assignment 
screen, which is used to assign badges and configure them for 
use with the unattended driver terminal. 

• Capture Digital Signature: This item opens the Capture Digital 
Signature screen, which is used to record a signature from an 
electronic signature pad and link it to a transaction. 

• Capture Payment: This item opens the Capture Payment 
screen, which is used to process credit card, debit card, check, 
and cash transactions. 

• Open Transaction Browser: This item opens the transaction 
browser, which displays a list of open transactions (two-pass 
and multi-pass transactions that have not been completed). 

• Payment Server Configuration: This item opens the Payment 
Server Configuration screen, which is used to set up 
communications with the PCCharge server. 

• Resource Editor: This item opens the resource editor, which is 
used to make changes to the OverDrive unattended resource 
files. 

• Scale Configuration: This item opens the Scale Configuration 
screen, which is used to connect to and configure unattended 
driver terminals and peripheral equipment. 

• Video Server Configuration: This item opens the Video Server 
Configuration screen, which is used to configure the video 
server cameras and assign a location for storing images 
captured by the cameras. 

• Virtual Scale: This item opens the virtual scale indicator or 
brings it to the front if it is behind another screen. The virtual 
scale indicator enables the computer operator to monitor the 
weight activity on one or more unattended driver terminals. 

Windows Menu 
The Windows menu is active only when a window is open. 

• Cascade: This item arranges all open windows one in front of 
another so that only the top and left edges of the windows in 
back are visible. 

• Tile Vertical: This item arranges all open windows side by side. 

• Tile Horizontal: This item arranges all open windows one 
above another. 

• Close All: This item closes all open windows. 

Help Menu: 
• Contents: For future use. 

• User Manual: This item opens the OverDrive unattended 
software user’s manual. 

• Register: This item opens the Registration screen. 
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• About: This item displays information about the version of 
OverDrive software you are using. 

 

 

Permissions 
The user permissions that are assigned in OverDrive software can 
affect a user’s access to the features in the OverDrive unattended 
application. The following list indicates which user permissions 
control access to unattended features. 

Access Transaction Wizard: Allows the user to start and stop the 
OverDrive unattended terminal. 

Application Settings Access: Allows access to the Application 
Settings screen. 

Badge Modify: Allows the user to view and modify the Badge 
Assignment screen. 

Badge View: Allows the user to view the Badge Assignment screen 
and query but not modify. 

Capture Payment Access: Allows access to the Capture Payment 
screen. 

Configure Scale Access: Allows the user to view and modify the 
Configure Scale window. 

Digital Signature Access: Allows access to the Capture Digital 
Signature screen. 

Isolated Images Modify: Allows the user to view and modify the 
isolated images. 

Isolated Images View: Allows the user to view but not modify the 
isolated images. 

Monitor OUDT Access: Allows access to the OUDT monitor. 

Notifications Modify: Allows the user to view and delete notifications. 

Notifications View: Allows the user to view but not delete 
notifications. 

Payment Server Access: Allows access to the Payment Server 
Configuration screen. 

Resource Editor Access: Allows the user to edit resource files. 

Scale Configuration Modify: Allows the user to view and modify the 
Scale Configuration screen. 

Scale Configuration View: Allows the user to view but not modify the 
Scale Configuration screen. 

Superuser: Allows access to all features and screens. 

Transaction Images Modify: Allows the user to view and modify the 
transaction images. 
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Transaction Images View: Allows the user to view but not modify the 
transaction images. 

Transaction Maintenance Modify: Allows the user to void 
transactions in the transaction browser. 

Video Server Configuration Access: Allows access to the Video 
Server Configuration screen. 
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Notifications 
OverDrive unattended software keeps a log of error messages and 
other notifications that the application sends to the operator. When a 
new notification is added to the log, the application will highlight the 
flag next to the Notifications message in the lower right-hand corner 
of the screen. 

 

 
 

To view the notification log, click on the Notifications message. 

 

 
 

The Notifications table includes filters that let you rearrange the 
messages listed in the table. Use the combo boxes in the table 
headings to select a filter that will display only the messages for a 
specific computer name, notification type, or notification message. 
Clicking the down arrow in the Date and Time heading switches 
between listing the messages according to the date or time of day 
when they were logged. 

The following table lists the system’s notifications and suggests 
possible solutions for correcting any errors. 

 

Notification Effects Possible Solutions 

Security Manager 
Failed to Initialize 

• The login User ID and 
password cannot be 
validated. 

• The user cannot log in to the 
application. 

• Check User ID and 
password. 

• Restart the application. 

• Contact local support team. 

Start OUDT Failed • Application cannot connect 
to the display, keyboard, and 
reader in the driver terminal. 

• Unattended application 
cannot operate. 

• Check configured IP 
addresses and ports for each 
driver terminal. 

• Check NPort 5110 in driver 
terminal for correct settings. 
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Notification Effects Possible Solutions 

• Check Ethernet connections. 

I/O Connection Failed • Application cannot connect 
to the ARM100 I/O module in 
the driver terminal. 

• Transactions can be 
processed, but inputs and 
outputs will not operate. 

• If loops are configured and 
required to enter the scale, 
then transactions cannot be 
processed. 

• Check configured IP address 
and port for the I/O module. 

• Check NPort 5130 in driver 
terminal for correct settings. 

• Check Ethernet connections. 

Start I/O Test Failed • Application cannot connect 
to the ARM100 I/O module in 
the driver terminal. 

• Inputs and outputs cannot 
be tested. 

• Check configured IP 
addresses and ports for each 
driver terminal. 

• Check NPort 5110 in driver 
terminal for correct settings. 

• Check Ethernet connections. 

Configure Report 
Failed 

• The report cannot be viewed 
or printed. 

• Make sure the report is in 
the correct directory. 

• Check the report 
configuration settings. 

OUDT Print Report 
Failed 

• The OUDT printer failed to 
print the report. 

• Make sure the correct driver 
is installed for the OUDT 
printer. 

• Make sure the OUDT printer 
is configured correctly. 

Destination Print 
Failed 

• The destination printer failed 
to print the report. 

• Make sure the destination is 
valid. 

• Make sure the destination 
printer is configured correctly. 

Print Report Failed • The default printer in the 
OverDrive system failed to 
print the report. 

• Make sure the default printer 
is valid. 

• Make sure the default printer 
is configured correctly. 

Login Failed for User / 
Encryption Manager 
Failed to Initialize 

• The login User ID and 
password cannot be 
validated. 

• The user cannot log in to 
application. 

 

• Restart the application. 

• Contact local support team. 
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Notification Effects Possible Solutions 

Login Failed for User / 
Invalid Login User ID 

• The User ID is invalid. 

• The user cannot log in to the 
application. 

• Log in as a different user. 

• Add the User ID in the 
OverDrive system. 

Login Failed for User / 
Specified User has 
Expired 

• The User ID cannot be used 
to log in to the application. 

• Log in as a different user. 

• Change the expiration date 
in the OverDrive system. 

Login Failed for User / 
Invalid Password 

• The password is invalid. • Check the password. 

• Change the password in the 
OverDrive system. 

Update of Scale File 
Failed 

• OverDrive system was not 
updated with the newly 
configured scale. 

• Reconfigure the scale in the 
unattended application. 

Invalid Multi Axle 
Weight 

• The transaction cannot be 
completed with an invalid 
multi-axle weight. 

• Check the scale’s units and 
increments against any 
completed passes. 

• Restart the transaction. 

Invalid Static Axle 
Weight 

• The transaction cannot be 
completed with an invalid 
static-axle weight. 

• Check the scale’s units and 
increments against any 
completed passes. 

• Restart the transaction. 

ODBC Connection 
Failed 

• Reports cannot be 
previewed or printed. 

• Make sure the ODBC is 
configured correctly. 

• Check the report settings in 
the Application Settings form. 

HMI Notification 
(Error) 

• The driver terminal cannot 
operate without a connection 
to the HMI. 

• Check the notification log for 
details about the error. 

• Check Ethernet connections. 

HMI Notification 
(Reconnect) 

• After reconnecting, the driver 
terminal should operate 
normally. 

• Not applicable. 

I/O Notification (Error) • The driver terminal can 
operate without a connection 
to the I/O as long as loops are 
not configured and required 
for weighing. 

• Check the notification log for 
details about the error. 

• Check Ethernet connections. 

I/O Notification 
(Reconnect) 

• After reconnecting, the 
inputs and outputs should 
operate normally. 

 

• Not applicable. 
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Notification Effects Possible Solutions 

Transaction Not Saved • The operator or driver 
cannot save the transaction to 
the database. 

• Verify database settings and 
communications. 

• Check Windows Event 
Viewer for details. 

• Contact local support team. 

Account Actual Credit 
Not Updated 

• The account’s actual credit 
value was not updated after 
the transaction was 
completed. 

• Check Windows Event 
Viewer for details. 

• Contact local support team. 

Contract Data Not 
Updated 

• Data relevant to a contract 
was not updated after the 
transaction was completed. 

• Check Windows Event 
Viewer for details. 

• Contact local support team. 

Product Data Not 
Updated 

• Data relevant to a product 
was not updated after the 
transaction was completed. 

• Check Windows Event 
Viewer for details. 

• Contact local support team. 

Weights and 
Measures Record Not 
Saved 

• A weights and measures 
record was not created after 
the transaction was 
completed. 

• Check Windows Event 
Viewer for details. 

• Contact local support team. 

 

 

 

How to Close 
the Program 

There are several ways to close the OverDrive program: 

• Click the Close button in the upper right-hand corner of the 
screen. 

• Select Exit from the File menu. 

• Click the Control Menu icon in the upper left-hand corner of the 
screen, and then select Close from the menu. 

• Type Alt+F4 on your computer keyboard. 



Chapter 4: Scale Configuration 
Introduction 

 

 

4   Scale Configuration 
 

 

Introduction 
OverDrive unattended software can communicate with unattended 
driver terminals that are used with as many as six scales (one or 
two terminals per scale). After installing an unattended driver 
terminal at a scale and connecting it to the computer network, use 
the tools described in this chapter to configure the scale. 

NOTE: Use the Scale Configuration screen to configure scales for 
both attended and unattended operation. If OverDrive unattended 
software is installed, do not use the Hardware Setup screen in the 
OverDrive application to configure scales or the hardware used 
with the scales. The Hardware Setup screen should be used only if 
the OverDrive unattended software is not installed. 

(4/09)   4-1 



METTLER TOLEDO OverDrive Unattended Software User’s Manual 
 
 

 

Configuration 
Open the Scale Configuration screen by selecting Scale 
Configuration in the Tools menu on the main OverDrive screen. 

 

 
 

The menu bar at the top of the screen provides the following menus: 

 

 
 

File Menu 
• Save: This item saves changes to the configuration settings for 

an individual scale. You will be prompted to save or cancel 
configuration changes for a scale before selecting another 
scale. 

• Exit: This item closes the screen. 

Tools Menu 
• Configure Scale: This item opens the Configure Scale window 

for the scale that is selected. The scale configuration settings 
are described later in this chapter. 
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• Monitor OUDT: This item opens the OUDT monitor, which lets 
you view activity on the unattended driver terminal for the scale 
that is selected. The OUDT monitor is described in Chapter 5. 

• Resource Editor: This item opens the resource editor, which is 
used to make changes to the OverDrive unattended resource 
files. The resource editor is described in Chapter 5. 

Actions Menu 
• Start OUDT: This item starts communication with the 

unattended driver terminal(s) at the scale that is selected. If the 
Auto Start feature is enabled, communication will start 
automatically when you log in to the OverDrive unattended 
application. 

• Stop OUDT: This item stops communication with the 
unattended driver terminal(s) at the scale that is selected. 
Communication will stop automatically when you log out of the 
OverDrive unattended application. 

• Zero Scale: This item zeroes the scale that is selected. In order 
for the system to zero the scale, the scale must be empty 
(within the zero range set for the scale terminal). 

• Test Keyboard: This item allows you to test the keyboard on the 
unattended driver terminal(s) at the scale that is selected. Click 
the menu item to enable it (placing a check mark next to it) or 
disable it (removing the check mark). With the test function 
enabled, press each key on the unattended driver terminal’s 
keyboard. When you press a key, the signal that the key sends 
will be displayed in the Keyboard Output field on the OUDT 
Configuration screen. Transactions cannot be processed at an 
unattended driver terminal while the test keyboard feature is 
enabled. 

Tool Bar 
The tool bar provides quick access to several frequently used 
commands from the menus. 

Start OUDT 

 This button starts communication with the unattended driver 
terminal(s) at the scale that is selected. If the Auto Start feature is 
enabled, communication will start automatically when you log in to 
the OverDrive unattended application. 

Stop OUDT 

 This button stops communication with the unattended driver 
terminal(s) at the scale that is selected. Communication will stop 
automatically when you log out of the OverDrive unattended 
application. 

Save 

 This button saves changes to the configuration settings. 
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Configure 
Scales 

OverDrive unattended software can communicate with as many as 
six scales. The status of each scale is shown in the sidebar on the 
left-hand side of the Scale Configuration screen. 

 

 
 

For each scale, the sidebar displays the scale name, the gross 
weight currently on the scale, a symbol (~) to indicate when the 
scale is in motion, and a symbol (>0<) to indicate that an empty 
scale is at zero. Asterisks (******) in the weight field indicate that 
the load on the scale is under/over the allowable weight range. 
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Status lights indicate whether the scale is connected (green) or 
disconnected (red). 

To select a scale, click on it. The settings for the scale that is 
selected are shown at the bottom of the sidebar. If the scale has not 
been configured, no scale settings will be shown. Each scale is 
configured individually. Any changes that you make to the 
configuration settings will affect only the scale that is selected. 

To configure a scale, select it and then open the Configure Scale 
window by selecting Configure Scale in the Tools menu on the Scale 
Configuration screen (or right click on the scale to open the menu). 

 

 
 

Enter the configuration settings for the scale and then click the OK 
button to save the settings or the Cancel button to close the window 
without saving them. 

Scale Name: A default name is assigned for each scale. Enter 
a new name if desired (maximum of nine 
characters). 

Enabled: Check the box to enable the scale. The scale will 
not display weights if it is not enabled. 

Communication 
Type: Select the type of communication connection to 

be used for the scale (Ethernet, Serial, or 
Summed). You will then need to configure the 
connection by clicking the Configure button and 
entering the settings. The Ethernet, Serial, and 
Summed Scale configuration windows are 
described in the following sections. 

NOTE: If you configure a summed scale, it will work for unattended 
operation but not for attended operation. 

Default Operation: For future use. 

Pass Minimum 
Weight: For future use. 
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Unit of Measure: Use the combo box to select the unit of measure 
that will be used for weighing (Kilograms, Metric 
Tons, Pounds, or Tons). The unit must match the 
unit selected for the scale terminal and OverDrive 
application setup options. 

Increment Size: Enter the increment size for the scale. The 
number that you enter will correspond to the unit 
selected in the Unit of Measure combo box. The 
increment size must match the increment size 
selected for the scale terminal and OverDrive 
application setup options. 
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Ethernet 
Configuration 

If you are using an Ethernet connection to transmit data between the 
scale terminal and computer, select the Ethernet radio button and 
then click the Configure button to open the Ethernet Configuration 
window. 

 

 
 

Enter the Ethernet configuration settings for the scale terminal and 
then click the OK button to save the settings or the Cancel button to 
close the window without saving them. The settings must match 
those of the terminal that is connected to the scale (for example, an 
IND310 terminal). 

IP Address: Enter the IP address for the scale terminal. 

Port: Enter the number for the scale terminal’s 
communication port that will be used for the 
Ethernet connection. 

TCP/UDP: Select a radio button to indicate whether the 
connection will use Transmission Control Protocol 
(TCP) or User Datagram Protocol (UDP). 

Scale: If you are using a Jaguar Shared Data format, 
select a scale (A, B, C, or D) from the combo box. 
E is used for a summed scale. 

Update Rate: The default value is set to 2, indicating how many 
times per second the data from the scale will be 
updated. 
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Format: Select the format for the type of terminal that is 
connected to the scale. Jaguar Shared Data is 
used for a JAGXTREME terminal. If you select a 
custom format, click the Configure button to 
configure the format. Custom formats are 
described later in this chapter. 

Enable Scale 
Control (CTPZ): Check this box to enable the scale to respond 

when a command to zero the scale is entered 
from a computer keyboard. The scale terminal 
must be configured to accept remote zero 
commands. 

Summed Scales 
If you are configuring an Ethernet connection for a summed scale 
(see page 4-11), the following fields will be included on the 
Ethernet Configuration window: 

Units: The unit selected for the summed scale must 
match the unit that is used for the scales that are 
being summed. 

Increment Size: The increment size for the summed scale must 
match the increment size that is used for the 
scales that are being summed. 

 

4-8   (4/09) 



Chapter 4: Scale Configuration 
Serial Configuration 

 

 

Serial 
Configuration 

If you are using a serial connection to transmit data between the 
scale terminal and computer, select the Serial radio button and then 
click the Configure button to open the Serial Configuration window. 

 

 
 

Enter the serial configuration settings for the scale terminal and then 
click the OK button to save the settings or the Cancel button to close 
the window without saving them. The settings must match those of 
the terminal that is connected to the scale (for example, an IND310 
terminal). 

Port Number: Select a communication port (1 to 8) from the 
combo box. 

Baud Rate: Select a baud rate from the combo box. 

Data Bits: Use the radio buttons to select 7 or 8 data bits. 

Stop Bits: Use the radio buttons to select 1 or 2 stop bits. 

Parity: Use the radio buttons to select the parity (None, 
Even, or Odd). 

Format: Select the serial format from the combo box. This 
setting must match the format of the scale terminal 
you are using. If you select a custom format, click 
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the Configure button to configure the format. 
Custom formats are described later in this chapter. 

Enable Scale 
Control (CTPZ): Check this box to enable the scale to respond 

when a command to zero the scale is entered 
from a computer keyboard. The scale terminal 
must be configured to accept remote zero 
commands. 

Summed Scales 
If you are configuring a serial connection for a summed scale (see 
page 4-11), the following fields will be included on the Serial 
Configuration window: 

Units: The unit selected for the summed scale must 
match the unit that is used for the scales that are 
being summed. 

Increment Size: The increment size for the summed scale must 
match the increment size that is used for the 
scales that are being summed. 
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Summed Scale 
Configuration 

A summed scale provides a weight reading that is the sum of the 
weights from two or more other scales. If you are using a scale for 
summing weights, select the Summed radio button and then click 
the Configure button to open the Summed Scale Configuration 
window. 

 

 
 

The scale name, unit of measure, and increment size for the 
summed scale are displayed at the top of the window. The tabs 
show the scales that are available to be connected to the summed 
scale. Check the box for each scale that you wish to sum. Right 
click on each scale and configure it for a serial or Ethernet 
connection (or clear an existing configuration). Then click the OK 
button to save the settings or the Cancel button to close the window 
without saving them. 

NOTE: If you configure a summed scale, it will work for unattended 
operation but not for attended operation. 
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Custom 
Formats 

You can configure a custom Ethernet or serial format for a scale 
terminal. NOTE: With a custom configuration, it is possible that 
some of a scale terminal’s features might not be supported. 

Select Custom in the Format combo box, and then click the 
Configure button. When the Custom Configuration screen opens, set 
the options on the screen’s tabs to match the configuration of the 
scale terminal. Then click the OK button to save the custom format 
or the Cancel button to close the screen without saving the changes. 

 

 
 

The Apply button lets you see how changes to the settings affect the 
weight reading, so that you can adjust the settings before saving 
them. Change the settings in the data fields on one of the tabs, and 
then click the Apply button. The actual weight and the raw data for 
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the weight will be displayed in the Response data fields. The 
changes will not be saved unless you click the OK button. 

Weight Update 

Timeout (msec): Enter the length of time (in milliseconds) that the 
system will pause between sending requests for a 
weight. This is for demand-mode terminals only. 

Weight Request 

Command: The command used to request a weight if the 
terminal is in demand mode. This is entered 
automatically when you select a special character. 

Special Chars: The character that the terminal must receive to 
start sending a weight. 

Enable Request: Check this box to require the system to request the 
weight. Checking this box enables the other two 
fields. 

Weight Response Format 

Start String Char: In the combo box, select the character that 
represents the start of the string. The 
corresponding ASCII character is entered 
automatically in the parallel field. 

Terminator Char: In the combo box, select the character that 
represents the end of the string. The corresponding 
ASCII character is entered automatically in the 
parallel field. 

Max Length: The maximum length of the entire string. 
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The Init tab is used to configure the system to communicate with a 
terminal that uses demand mode and returns a string containing the 
weight. It is not needed for terminals that are in continuous mode. 

Initialize Request 

Command: The command used to initialize the terminal to 
request the string. This is entered automatically 
when you select the special character. 

Special Char: The character that the terminal must receive to 
start sending the string. 

Initialize Response 

Init Responds: Checking this box enables configuration of the 
preamble and postamble to the response from the 
terminal. 

Preamble Char: In the combo box, select the special character that 
represents the start of the string with which the 
terminal will respond. 
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Postamble Char: In the combo box, select the special character that 
represents the end of the string with which the 
terminal will respond. 

Max Length: Enter the maximum length of the entire string. 

Returned Units 

Offset: The number of characters from the left end of the 
string to the character(s) representing the weight 
unit. Setting the offset to -1 disables the function. 

Length: The number of characters used to represent the 
weight unit. 

 

 
 

Net Weight 

If the string contains the net weight and another weight (gross 
weight, tare weight, etc.), indicate which weight is the net weight. If 
the string contains only one weight, this setting is not needed. 
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Offset: The number of characters from the left end of the 
string to the character(s) representing the net 
weight. 

Length: The number of characters used to represent the net 
weight. 

Implied Decimal Point 

If the terminal uses a decimal point, these settings will determine 
how the system reads it. 

Num DP Digits: Enter the number of digits that follow the decimal 
point. 

DP Character: Enter the ASCII code for the character that 
represents the decimal point. 

Negative Weight Test 

These settings indicate how to check for a negative weight. 

Offset: The number of characters from the left end of the 
string to the character(s) representing the negative 
weight. 

Mask: Enter the ASCII character that represents the 
negative weight indication. 

Test Type: And and NAnd are not used in this setting. 

 Equal states that the desired result is equal to the 
mask. For example, if you set the mask to 45 
(ASCII code for the - sign) and select Equal, a “-“ 
in the string will be interpreted as a negative 
weight. 

 Not Equal states that the desired result is not 
equal to the mask. For example, if you set the 
mask to 45 (ASCII code for the - sign) and select 
Not Equal, anything but a “-“ in the string will be 
interpreted as a negative weight. 

 None disables the function. 
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Weight Units 

Offset: The number of characters from the left end of the 
string to the character(s) representing the 
weighing unit. Setting the offset to -1 disables the 
function and uses the default units. 

Length: The number of characters used to represent the 
weighing unit. 

Default Weight Units 

Default Unit  

String: Enter a default unit if you do not wish to receive 
the unit from the terminal or if the unit does not 
exist or is not accessible. The system will use this 
unit when processing transactions. 
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Motion Detection Test #1 

Offset: The number of characters from the left end of the 
string to the character(s) representing motion. 

Mask: Enter the ASCII character that represents motion. 

Test Type: And states that if the desired result and the result 
from motion detection test #2 are found, then 
interpret as in motion. 

 NAnd states that if the desired result or the result 
from motion detection test #2 are found, then 
interpret as in motion. 

 Equal states that the desired result is equal to the 
mask. For example, if you set the mask to 126 
(ASCII code for the ~ sign) and select Equal, a “~“ 
in the string will be interpreted as in motion. Use 
this setting if there is no motion detection test #2. 

 Not Equal states that the desired result is not 
equal to the mask. For example, if you set the 
mask to 126 (ASCII code for the ~ sign) and 
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select Not Equal, anything but a “~“ in the string 
will be interpreted as in motion. Use this setting if 
there is no motion detection test #2. 

 None disables the function. 

Motion Detection Test #2 

Use this test if there is more than one character representing motion. 
See Motion Detection Test #1 for an explanation of the settings. 

 

 
 

Overrange Detection Test #1 

Offset: The number of characters from the left end of the 
string to the character(s) representing overrange. 

Mask: Enter the ASCII character that represents 
overrange. 

Test Type: And states that if the desired result and the result 
from overrange detection test #2 are found, then 
interpret as overrange. 
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 NAnd states that if the desired result or the result 
from overrange detection test #2 are found, then 
interpret as overrange. 

 Equal states that the desired result is equal to the 
mask. For example, if you set the mask to 126 
(ASCII code for the ~ sign) and select Equal, a “~“ 
in the string will be interpreted as overrange. Use 
this setting if there is no overrange detection test 
#2. 

 Not Equal states that the desired result is not 
equal to the mask. For example, if you set the 
mask to 126 (ASCII code for the ~ sign) and 
select Not Equal, anything but a “~“ in the string 
will be interpreted as overrange. Use this setting if 
there is no overrange detection test #2. 

 None disables the function. 

Overrange Detection Test #2 

Use this test if there is more than one character representing 
overrange. See Overrange Detection Test #1 for an explanation of 
the settings. 
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The fields on the CTPZ tab will be active only if the Enable Scale 
Control (CTPZ) box is checked on the Ethernet Configure or Serial 
Configure window. 

CTPZ Command Strings 

Clear: In the combo box, select the character 
representing the clear command that the terminal 
uses. The correct ASCII character will then be 
entered into the blank field. 

Tare: In the combo box, select the character 
representing the tare command that the terminal 
uses. The correct ASCII character will then be 
entered into the blank field. 

Print: In the combo box, select the character 
representing the print command that the terminal 
uses. The correct ASCII character will then be 
entered into the blank field. 
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Zero: In the combo box, select the character 
representing the zero command that the terminal 
uses. The correct ASCII character will then be 
entered into the blank field. 
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ASCII Characters 
 

ASCII CHR  ASCII CHR  ASCII CHR  ASCII CHR 

0 NUL  32 SP  64 @  96 ‘ 
1 SOH  33 !  65 A  97 a 
2 STX  34 "  66 B  98 b 
3 ETX  35 #  67 C  99 c 
4 EOT  36 $  68 D  100 d 
5 ENQ  37 %  69 E  101 e 
6 ACK  38 &  70 F  102 f 
7 BEL  39 '  71 G  103 g 
8 BS  40 (  72 H  104 h 
9 HT  41 )  73 I  105 i 
10 LF  42 *  74 J  106 j 
11 VT  43 +  75 K  107 k 
12 FF  44 ,  76 L  108 l 
13 CR  45 -  77 M  109 m 
14 SO  46 .  78 N  110 n 
15 SI  47 /  79 O  111 o 
16 DLE  48 0  80 P  112 p 
17 DC1  49 1  81 Q  113 q 
18 DC2  50 2  82 R  114 r 
19 DC3  51 3  83 S  115 s 
20 DC4  52 4  84 T  116 t 
21 NAK  53 5  85 U  117 u 
22 SYN  54 6  86 V  118 v 
23 ETB  55 7  87 W  119 w 
24 CAN  56 8  88 X  120 x 
25 EM  57 9  89 Y  121 y 
26 SUB  58 :  90 Z  122 z 
27 ESC  59 ;  91 [  123 { 
28 FS  60 <  92 \  124 | 
29 GS  61 =  93 ]  125 } 
30 RS  62 >  94 ^  126 ~ 
31 US  63 ?  95 _  127 DEL 
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OUDT 
Display 

The Scale Configuration screen lets you view activity on the 
unattended driver terminal’s display and enter messages. This 
makes it easy to communicate with drivers who are processing 
transactions at the terminal. Seven lines of text are available for 
typing messages. The eighth line is used for displaying the weight. 

 

 
 

1. Click the Clear button to clear the prompt from the screen and 
enable the Send button. 

2. Place the cursor on the desired line and type a message. 

3. Click the Send button to display the message on the 
unattended driver terminal at the scale. 

4. Clicking the Clear button will delete the message. To send 
additional messages, repeat steps 2 and 3. 

5. When you are done communicating with the driver, click the 
Reset button to reset the terminal so that it displays the most 
recent prompt. 

The Advanced button opens the Advanced Display Settings window, 
which is used to adjust the visibility of the unattended driver 
terminal’s display. If there are two unattended driver terminals at a 
scale, you can enter separate settings for each terminal. 
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Contrast: Move the pointer along the sliding scale to adjust 
the contrast of the terminal’s display. 

Backlight On?: Place a check mark in the box to turn on the 
display’s backlight, or remove the check mark to 
turn off the backlight. 

Backlight 
Brightness: Move the pointer along the sliding scale to adjust 

the brightness of the backlight. 

Input Devices 

These fields are used to monitor the data that the driver enters at the 
unattended driver terminal. 

Keyboard Output: This field shows the data that the driver enters 
using the unattended driver terminal’s keyboard. 
The data will not appear in the field until the driver 
selects the Enter command. 

Reader Output: This field shows the data that the driver enters 
using the unattended driver terminal’s badge 
reader. 
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General Tab 
The General tab lets you enter basic information about how the 
unattended driver terminal will operate. 

 

 
 

Scale Type: Use the Scale Type combo box to select Full 
Length Scale, Axle Scale, or Split Weigh Scale. A 
full-length scale is used to weigh an entire vehicle. 
An axle scale or split-weigh scale is used to weigh 
portions of a vehicle separately and then sum the 
weights together. 

Threshold 
Weight: Enter a threshold weight. When the weight reading 

reaches this level, it signals to the system that a 
vehicle is on the scale. This weight should be 
higher than the pass minimum weight. 

Pass Minimum 
Weight: Enter a pass minimum weight. When the weight 

reading is below this level, it signals to the system 
that a vehicle has left the scale and a new pass 
can begin. The pass minimum weight must be 
greater than or equal to the zero-tolerance weight. 

Zero Tolerance 
Weight: Enter a weight range (± the number entered) 

within which the scale is considered to be at zero 
and ready to begin a transaction. This weight is 
used only when a scale is equipped with traffic 
loops, and it must be less than or equal to the 
pass minimum weight. 
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End Pass 
Time (seconds): Enter the number of seconds that you want the 

traffic lights to remain red after the weight goes 
below the threshold weight value. 

Enabled: Check this box to enable the scale for use with an 
unattended driver terminal. The scale must be 
enabled in order for the unattended driver terminal 
to be started. 

Auto Start: Check this box if you want the unattended driver 
terminal(s) to start automatically each time a user 
logs in to the OverDrive unattended application. If 
the box is not checked, the operator must start 
each terminal manually. 

 

Advanced Tab 
 

 
 

Abort on 
Loop Break: Check this box if you want the current transaction 

to be aborted when there is a loop break. This 
feature aborts the transaction that is being 
processed for a vehicle on the scale if a second 
vehicle drives over the scale’s traffic loop while the 
transaction is in progress. 

Badge Only 
Transactions: Check this box to allow only transactions that are 

initiated with a badge. This feature requires drivers 
to start unattended transactions by identifying 
themselves with a badge (additional data can be 
entered using the keyboard). 

Show Confirmation 
Prompt: Check this box to display a confirmation prompt 

on the unattended driver terminal. The 
confirmation tells the driver that the system has 
captured the information required for a pass and 
prompts the driver to accept or cancel the pass. 

Show Language 
Prompt: Check this box to display a language selection 

prompt on the unattended driver terminal. The 
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prompt allows drivers to switch the text on the 
display from the default language to another 
language. 

Show ID and 
Description: Check this box to show both the ID and 

description for database records (such as 
products) that are displayed on the unattended 
driver terminal. If the box is not checked, the 
terminal will show only the ID. Because of space 
limitations, the terminal’s display will not show 
long descriptions in their entirety. 

Disable Driver  
Input when not 
OK to Weigh: Check this box to prevent drivers from entering 

data at the unattended driver terminal until all 
requirements for weighing have been met (for 
example, the weight on the scale is above the 
threshold weight). 

Show Weight 
on Display: Use the radio buttons to define when the current 

weight is shown on the unattended driver 
terminal’s display (Always, Never, or Valid Badge 
Only). The third option displays the weight only 
when a valid badge has been used to identify the 
vehicle that is on the scale. 

Barrier to Open 
on Abort: When a scale is equipped with barriers, OverDrive 

unattended software allows the driver to abort a 
transaction and open the barriers so that the 
vehicle can exit the scale. Use the radio buttons to 
define which barriers will open automatically when 
a transaction is aborted. 

• Entrance: Opens the entrance barrier only. 

• Exit: Opens the exit barrier only. 

• Both: Opens both entrance and exit barriers. 

• Default: Opens the barrier in the current direction 
of travel. 

NOTE: The radio buttons are active only if the 
current I/O configuration includes barriers. 
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Transients Tab 
Transient vehicles are vehicles for which there is no database record 
in the Vehicle table. 

 

 
 

Allow Transient 
Vehicles: Check this box to enable the unattended driver 

terminal to process transactions for transient 
vehicles. 

The following two fields will be active only when the Allow Transient 
Vehicles box is checked. 

Transaction Type: Select the transaction type to be used for transient 
vehicles. To add a transaction type to the combo 
box, you must create it with the OverDrive 
Transaction Type Wizard. 

Carrier ID: Select the Carrier ID that will be assigned for all 
transient vehicles. In order to complete a vehicle-
weighing transaction, the vehicle must be 
assigned to a carrier. Use the OverDrive Carrier 
form to create a Carrier ID for use with transient 
vehicles. 

 

Axle/Split Tab 
 

 
 

Axle and split weighing involve capturing a series of weights and 
require a driver to reposition a vehicle on the scale before each 
weight in the series can be captured. Each time a vehicle is 
repositioned on the scale is called an excursion. The excursion 
weight and excursion time settings work together to signal when an 
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excursion has been completed and the scale is ready to capture the 
next weight in the series. For example, after the first weight in an 
axle-weighing sequence has been captured, a green light will signal 
the driver to start an excursion by moving the vehicle to the second 
weighing position. The light will remain green for at least the 
excursion time while waiting for the weight on the scale to increase 
or decrease by at least the excursion weight. When both conditions 
have been met (the minimum excursion time has elapsed and the 
minimum excursion weight change has occurred), a red light will 
signal that the excursion has been completed and the next weight in 
the series can be captured. 

Allow Static 
Axle Weights: Check this box to enable static-axle weighing on a 

full-length scale. To start this type of weighing 
transaction, position the truck’s first axle on the 
scale. When the weight of the axle is captured, the 
traffic light signals the truck to move forward to 
position the first and second axles on the scale. 
The weight of the two axles is then captured. The 
truck continues moving forward, capturing the 
weight of an additional axle for each excursion 
until the entire truck is positioned on the scale for 
the final weighing. The system will store the 
weight of the entire truck and use the excursion 
weights to calculate a weight for each axle. 

The Allow Static Axle Weights check box is active 
only when full-length scale is selected as the scale 
type. For static-axle weighing, you must set a 
threshold weight (which must be lower than the 
weight of any truck’s first axle), pass minimum 
weight, zero-tolerance weight, end-pass time, 
excursion weight, excursion time, and end-cycle 
time. 

NOTE: The individual axle weights calculated 
during static axle weighing are for information 
only (they are not legal-for-trade). Depending on 
external factors, the sum of the axle weights might 
not equal the gross weight of the entire truck. 
Several factors can affect the axle weights, 
including the driver exiting the truck after the axle 
weights have been captured, the slope or grade of 
the approach ramp to the scale, and the angle or 
position of the truck on the scale. 

Enforce 
Number of Axles: Check this box to require that the same number of 

axles is weighed for each pass of an axle-
weighing transaction. This check box is active 
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only when axle weighing or static-axle weighing is 
enabled. 

Excursion 
Weight: Enter an excursion weight. When the weight 

reading increases or decreases by at least this 
amount, it signals to the system that the vehicle 
has moved. 

Excursion 
Time (seconds): Enter the minimum time (in seconds) that the 

system will signal to the driver that a weight has 
been captured. This signal is usually given by a 
green traffic light that lets the driver know it is okay 
to move the vehicle. The traffic light will remain 
green for at least the number of seconds entered in 
the data field. 

End Cycle 
Time (seconds): Enter an end cycle time (5 to 10 seconds is 

typical). When a scale has been empty for this 
length of time, the system assumes that the final 
weight has been captured and the vehicle has left 
the scale. 

 

Payment/Signature Tab 
When payment is required to complete a transaction, the OverDrive 
application will place the transaction on hold until the payment is 
processed. If the unattended terminal is equipped with a credit card 
reader, the driver can complete the transaction by paying at the 
terminal with a credit card. Otherwise, the typical procedure is to 
have the unattended terminal issue a hold ticket to the driver when 
the final weighing of a transaction is completed. The driver then 
presents the ticket at the scale house or office and completes the 
transaction by paying the scale operator with a credit card, debit 
card, check, or cash. When a signature is required to complete a 
transaction, a similar procedure is used to prompt the driver to sign 
an electronic signature pad at the terminal or inside the scale house. 

 

 
 

Use this tab to indicate how the unattended terminal will prompt 
drivers to complete their transactions. 
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1. If payment or signature is required, check one of the boxes: 

 Always on Hold - Requires drivers to pay inside. 

 Show Payment Prompt - Prompts drivers to choose 
between paying at the terminal or inside. 

 Always on Signature Hold - Requires drivers to sign 
inside. 

 Show Signature Prompt - Prompts drivers to choose 
between signing at the terminal or inside. 

2. Select a ticket format in the Payment Hold Ticket or Signature 
Hold Ticket combo box. A hold ticket will be printed when a 
driver is required to pay or sign inside and when a driver 
chooses to pay or sign inside. 

 

 

Hardware 
Tab 

The Hardware tab lets you configure hardware connections for the 
unattended driver terminal(s). 

 

 
 

Number of 
Driver Terminals: Select the number of unattended driver terminals 

used at the scale. Each scale can support as 
many as two terminals. You will be able to 
configure hardware connections for as many 
terminals as you select. 

NOTE: Selecting “0” (zero) as the number of driver 
terminals for a scale enables you to use the scale 
without a driver terminal. It automatically puts the 
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scale in operator override mode, allowing a scale 
operator to process transactions from the OUDT 
monitor. Transactions processed from the OUDT 
monitor enable you to use the transaction wizard, 
video server, and credit card functions. 

IP Address: Enter the IP address for the unattended driver 
terminal. 

Port: Enter the communication port number for the 
unattended driver terminal. 

Keyboard: Select the type of keyboard used by the terminal 
(none, numeric, or alphanumeric). 

Display: Select the type of display used by the terminal 
(none or 240 x 128 LCD display). 

Reader: Select the type of badge reader used by the 
terminal (none, AWID 26, Bar Code, SmartPass 
5112 Tags, SmartPass 5510 Tags, or ERO 
badges). 

Printer: Select a printer for the unattended driver terminal. 
The printer selected in this field will print a ticket 
automatically for each unattended transaction. To 
list a printer in the combo box, you must install 
the printer driver. 

NOTE: In order to print tickets at the unattended 
driver terminal, you must adjust the following 
settings in the OverDrive program: 

• Select a ticket format for each account that 
will use the unattended driver terminal. The 
Account table allows you to select formats for 
inbound and outbound tickets. 

• The Destinations tab on the Report screen is 
also used to select printers. If you select a 
printer on both the Hardware tab and the 
Destinations tab, the system will print two 
tickets for unattended transactions. To print 
tickets only at the unattended driver terminal, 
select a printer on the Hardware tab but do 
not specify a printer on the Destinations tab. 
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I/O 
Configuration 
Tab 

The I/O Configuration tab lets you configure the inputs and outputs 
(I/O) for an unattended driver terminal. 

 

 
 

Number of 
I/O Boards: Select the number of I/O boards used for the scale. 

Each scale can support as many as two I/O 
boards. You will be able to configure inputs and 
outputs for as many I/O boards as you select. 

I/O IP Address: Enter the IP address for the I/O board. 

I/O Port: Enter the communication port number for the I/O 
board. 

I/O Configuration 
Number: OverDrive unattended software provides predefined 

I/O configurations that simplify the setup 
procedure. Select one of the predefined 
configurations from the combo box to configure 
the input and output connections automatically. 
When you select a predefined I/O configuration 
number, a brief description of the setup is 
provided in the field below the combo box. To see 
a detailed description of the setup and how it 
would be used to process transactions, click on 
the link to the right of the combo box. The 
description of I/O Configuration Number 1 is 
shown below. 
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User-Defined I/O Configurations 
If the predefined configurations do not meet your needs, you can 
define a custom I/O configuration. NOTE: With a custom 
configuration, it is possible that some types of connections might 
not be supported. We recommend that you test user-defined I/O 
settings to make sure that they work before installing the system on 
site. 

Select 0 as the I/O Configuration Number and then use the combo 
boxes on the ARM100 #1 tab to configure the input and output 
connections. If the scale has two I/O boards, use the combo boxes 
on the ARM100 #2 tab to configure the input and output 
connections for the second board. The combo boxes allow you to 
select from the following options: 

Outputs: 

0 – Nothing Connected 

1 – Entrance Traffic Signal Direction 1 

2 – Exit Traffic Signal Direction 1 

3 – Entrance Traffic Signal Direction 2 

4 – Exit Traffic Signal Direction 2 

5 – Entrance Barrier (Gate) 

6 – Exit Barrier (Gate) 

7 – Entrance Green Traffic Signal Direction 1 

8 – Entrance Red Traffic Signal Direction 1 
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9 – Exit Green Traffic Signal Direction 1 

10 – Exit Red Traffic Signal Direction 1 

11 – Entrance Green Traffic Signal Direction 2 

12 – Entrance Red Traffic Signal Direction 2 

13 – Exit Green Traffic Signal Direction 2 

14 – Exit Red Traffic Signal Direction 2 

Inputs: 

0 – Nothing Connected 

1 – Entrance Loop 

2 – Exit Loop 

3 – Entrance Photoeye 

4 – Exit Photoeye 

5 – Push Button 

 

 

I/O Testing 
Tab 

The I/O Testing tab lets you test the I/O connections and 
configurations for a scale. 

 

 
 

Test I/O Connections 

Click the Start button to begin testing the I/O connections. 

• Use the radio buttons to test the ARM100 outputs. Check each 
device to make sure it responds correctly as the radio button is 
switched on and off. For example, the traffic lights in predefined 
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I/O Configuration Number 1 are set to turn green when the 
output is on and turn red when it is off. 

• Activate the ARM100 inputs (for example, by driving onto a 
traffic loop). The indicator should display green when it is 
activated and red when it is not activated. 

Click the Stop button to end the test procedure. 

Test I/O Configuration 

Click the Start button to test the predefined I/O configuration for the 
scale. The I/O Configuration Test window will open. 

 

 
 

If a configuration allows traffic in two directions, use the radio 
buttons to select the direction being tested. Click the Next Step 
button to move from step to step through the predefined transaction 
procedure. At each step, the lights will indicate the status of the 
device for that step. Click the Stop button to end the test procedure. 

NOTE: This feature is used to test predefined I/O configurations. It 
cannot be used to test custom I/O configurations. 
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Add-On 
Devices Tab 

The Add-On Devices tab lets you connect to badge readers and 
other peripheral devices that are used with the unattended driver 
terminal. NOTE: Some add-on devices might not be compatible with 
the software. To find out if a device is compatible, contact your 
METTLER TOLEDO representative. 

 

 
 

Number of 
Add-Ons: Each unattended driver terminal can be connected 

to as many as three add-on devices. Select the 
number of devices for each terminal and then 
define the following information for each device: 

IP Address: Enter the IP address for the device. 

Port: Enter the communication port number for the 
device. 

Device: Select the type of communication device from 
those listed in the combo box: 

0 – Nothing Connected 

1 – AWID 26 

2 – Barcode 

3 – SmartPass 5112 Tags 

4 – SmartPass 5510 Tags 

5 – Credit Card Reader 

6 – Digital Signature Pad 

7 – ERO Badge 
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5   Other OverDrive Unattended Tools 
 

 

Introduction 
The OverDrive unattended Tools menu provides access to the 
following tools for configuring unattended operations and 
processing transactions: 

 

 Options (for future use) 

 Application Settings 

 Badge Assignment 

 Capture Digital Signature 

 Capture Payment 

 Open Transaction Browser 

 Payment Server Configuration 

 Resource Editor 

 Scale Configuration (see Chapter 4) 

 Video Server Configuration 

 Virtual Scale 
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Application 
Settings 

The Application Settings screen is used to display database 
information, configure the function keys on the unattended driver 
terminal, set time intervals for the terminal, and set up 
communications for the video server and credit card options. To 
open the screen, select Application Settings in the Tools menu. After 
making changes to the application settings, click the OK button to 
save the changes or click the Cancel button to cancel them. 

 

Database Tab 
The Database tab displays settings for the OverDrive database and 
the ODBC driver. 

 

 
 

Database 

The Database fields display information about the OverDrive 
database. 

Database Version: The software version of the OverDrive database. 

Server Information: The location where the database is installed. 
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Database Name: The name of the database. 

User ID: The user ID assigned to the database. 

Password: The password assigned to the database. 

Test: Click this button to test the connection to the 
database. 

NOTE: Changing the data in these fields will affect the connection to 
the database and might prevent you from starting the OverDrive 
unattended application. If the application does not start, you can edit 
the application settings using OverDrive Utilities (ODUtils.exe). The 
default location for ODUtils.exe is C:\Program Files\Mettler 
Toledo\OverDrive OUDT. OverDrive Utilities also provides access to 
the resource editor. 

Report 

The Report fields display information about the report ODBC driver 
that interfaces with the database. 

Server Name: The location where the ODBC driver is installed. 

Database Name: The name of the database. 

User ID: The user ID assigned to the database. 

Password: The password assigned to the database. 

Test: Click this button to test the connection to the 
report ODBC driver. 

Auto Login 

The Auto Login fields are used to enable or disable the auto login 
feature. When auto login is enabled for a user, the user can start the 
OverDrive unattended application without entering a password. 

NOTE: Auto login can be enabled for only one user ID. If you enable 
auto login for user1 and then change the user ID and password to 
enable it for user2, the feature will be disabled for user1. 

Enable Auto Login: Check this box to enable auto login for the user 
whose user ID and password are entered in the 
following data fields. 

User ID: The user ID assigned for the application. 

Password: The password assigned for the application. 
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OUDT Settings Tab 
The OUDT Settings tab is used to assign an action to each function 
key on the unattended driver terminal’s keyboard. 

 

 
 

To program a function key, select one of the following actions from 
the combo box for the function key: 

• 0 – (none): This option disables the function key. 

• 1 – Zero Scale: The function key will set a scale’s weight 
reading to zero. In order for the zero scale command to work, 
the scale must be empty (within the zero range set for the scale 
terminal). 

• 2 – Reset Display: The function key will reset the unattended 
driver terminal’s display to the last prompt that was on screen 
before the key was pressed. 

• 3 – Print Last Ticket: The function key will print a new copy of 
the ticket for the transaction that was just completed. A vehicle 
must remain on the scale in order to reprint a ticket. After a 
vehicle exits the scale (the weight on the scale falls below the 
threshold weight), the ticket can no longer be reprinted. 
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• 4 – Complete Pass: The function key will complete the current 
pass over the scale. It can be used for all passes except the 
final pass of a multi-pass transaction. 

• 5 – Complete Multi Pass: The function key will complete the 
final pass of a multi-pass transaction. 

• 6 – Contrast Down: The function key will decrease the contrast 
of the unattended driver terminal’s display. 

• 7 – Contrast Up: The function key will increase the contrast of 
the unattended driver terminal’s display. 

 

Time Intervals Tab 
The Time Intervals tab is used to specify the amount of time that the 
unattended driver terminal will wait before performing certain 
actions. 

 

 
 

To set a time interval, enter the desired number of seconds in the 
field for that interval. 

• Scale Not Ready: The number of seconds that the terminal will 
wait before displaying a “Scale Not Ready” message when a 
driver enters a command to complete a pass but the weight on 
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the scale does not meet the threshold requirement or I/O 
sequence. 

• Scale In Motion: The number of seconds that the terminal will 
wait before displaying a “Scale In Motion” message when a 
driver enters a command to complete a pass but there is 
motion on the scale. 

• Badge Read Delay: The number of seconds that the terminal 
will wait before accepting another badge entry. This prevents 
the reader from accepting multiple entries when a badge is held 
in front of the reader. 

• Timeout: The number of seconds that the terminal will allow a 
vehicle to complete an axle-weighing or split-weighing 
transaction. If a transaction is not completed within the 
specified time, it will be aborted. This feature resets the terminal 
if a truck leaves the scale without completing a transaction. 

 

TCP Engine Tab 
The TCP Engine tab is used to enable the Transmission Control 
Protocol (TCP) engine to set up communication between the 
OverDrive unattended application and the video server PC. 
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Enable  
TCP Engine: Check this box to enable the TCP engine. 

Host Name: The name of the host computer where the 
OverDrive unattended application is installed. 

Port: The communication port to which the video 
server is connected. 

Network Adapter: Select the network adapter used to communicate 
with the video server. Local Area Connection is 
the preferred adapter. 

Network Adapter Details 

The following fields display information about the network adapter 
that is selected. 

ID: The identifier for the network adapter. 

Name: The name of the network adapter. 

Description: A description of the network adapter. 

 

Local Devices Tab 
The Local Devices tab is used to set up communications with a 
credit card reader, cash drawer, and digital signature pad connected 
directly to a serial port on the computer. 

 

 

(4/09)   5-7 



METTLER TOLEDO OverDrive Unattended Software User’s Manual 
 

 

Credit Card Reader 

1. Check the Enabled box to enable communication with the 
credit card reader. 

 
2. Click the Configure COM Port button to open the Serial 

Configuration window. 

 

 
 

3. Enter the serial port configuration settings for the credit card 
reader: 

 Port Number: Select the serial communication port. 

 Baud Rate: Select the baud rate. 

 Data Bits: Select the number of data bits (5, 6, 7 or 8). 

 Parity: Select the parity (None, Even, or Odd). 

 Stop Bits: Select the number of stop bits (1, 1.5, or 2). 

4. Click the OK button to save the serial port settings or click the 
Cancel button to cancel any changes. 

 

Cash Drawer 

1. Check the Enabled box to enable communication with the cash 
drawer. 

 
2. Click the Configure COM Port button to open the Serial 

Configuration window. 
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3. Enter the serial port configuration settings for the cash drawer: 

 Port Number: Select the serial communication port. 

 Baud Rate: Select the baud rate. 

 Data Bits: Select the number of data bits (5, 6, 7 or 8). 

 Parity: Select the parity (None, Even, or Odd). 

 Stop Bits: Select the number of stop bits (1, 1.5, or 2). 

4. Click the OK button to save the serial port settings or click the 
Cancel button to cancel any changes. 

5. In the Trigger field, enter the code used to open the cash 
drawer. The code should be provided by the cash drawer 
manufacturer. 

 

Digital Signature Pad 

1. Check the Enabled box to enable communication with the 
digital signature pad. 

 
2. Click the Configure COM Port button to open the Serial 

Configuration window. 
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3. Enter the serial port configuration settings for the digital 
signature pad: 

 Port Number: Select the serial communication port. 

 Baud Rate: Select the baud rate. 

4. Click the OK button to save the serial port settings or click the 
Cancel button to cancel any changes. 
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General Tab 
The General tab is used to select a location for storing digital 
signatures that are captured from a signature pad connected to the 
computer or driver terminal. 

 

 
 

Select a location where the digital signatures will be saved: 

 Database - The database where OverDrive transaction 
information is stored. 

  Directory - Use the browse button to select a network directory. 
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Badge 
Assignment 

The Badge Assignment screen lets you enter information about 
badges used to identify vehicles, accounts, carriers, companies, 
containers, contracts, products, or trailers. Before a badge can be 
used at an unattended driver terminal, you must create a badge 
record and link the badge to it. The Detail View tab is used to create 
and view an individual badge record. The List View tab is used to 
view more than one record. 

 

 
 

Data Fields 
Enabled: Check this box to enable a badge record. 

AWID26  
Badge ID: The number printed on an AWID26 badge. 

Badge ID: The badge number (or the internal AWID badge 
code). 

Table Selection: Select the table that contains the record to which 
the badge will be linked (Account, Carrier, 
Company, Container, Contract, Product, Trailer, 
or Vehicle). 

Field Selection: Select the database record to which the badge 
will be linked. The combo box lists all records 
from the table that is selected above. 

Carrier Vehicle 
Reference: If a vehicle is entered as the field selection, this 

combo box will display the carrier linked to the 
vehicle. If a carrier is entered as the field 
selection, this combo box will list the vehicles 
linked to the carrier. 
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Push Buttons 

 
Convert AWID26 
Badge ID: Click this button to convert the number that is 

typed in the AWID26 Badge ID data field. 

Tool Bar 
The push buttons on the tool bar are used to view or edit records in 
the database table. You can use the buttons from both the Detail 
View and List View tabs. 

 

 
Find: Searches for records in a database table. In the initial version 
of the software, clicking this button will retrieve all records. Full-
featured search capabilities will be added in the future. 

 

 
New: Clears all records that are displayed on a form or table. This 
lets you begin a new search or begin entering data to create a new 
record. 

 

Save: Saves a new database record or saves changes made to an 
existing database record. 

 
 

 
Delete: Deletes the database record that is currently displayed on a 
form. 

 

 
First: Returns to the first record in a table. The keyboard shortcut for 
this command is Ctrl-Up Arrow. 

 

 
Previous: Returns to the previous record. The keyboard shortcut for 
this command is Ctrl-Left Arrow. 

 

 
Next: Goes forward to the next record. The keyboard shortcut for this 
command is Ctrl-Right Arrow. 

 

Last: Goes forward to the last record in a table. The keyboard 
shortcut for this command is Ctrl-Down Arrow. 

 

When you retrieve a list of records and select one of them, the data 
field on the tool bar shows the number of the record that is selected 
and the total number of records that were retrieved. The total number 
of records in the database table will be shown on the message bar 
at the bottom of the screen. 
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AWID26 
Badges 

Use the following procedure to enter an AWID26 badge number into 
the database so that the badge can be used at an unattended driver 
terminal: 

1. In the AWID26 Badge ID data field, type the number that is 
printed on the badge. 

2. Click the Convert AWID26 Badge ID button. The badge number 
will be entered into the system, and the internal badge code 
will appear in the Badge ID data field.  

3. Use the Table Selection and Field Selection combo boxes to 
link the badge to a database record, such as a Vehicle ID. 

4. Click the Save button to save the Badge ID record. 

 

Scanning 
Badges 

When entering SmartPass 5112 and 5510 badges, you will need to 
scan each badge at a badge reader (AWID26 badges can also be 
entered this way). The Badge Assignment screen gives you the 
option of entering a badge by scanning it at an unattended driver 
terminal’s badge reader or at a badge reader connected to the 
computer’s serial port. Use the following procedure to enter a badge 
into the database so that the badge can be used at an unattended 
driver terminal: 

 

Badge Reader at an Unattended Driver Terminal 
1. Select the By Driver Terminal radio button. 

2. In the Scale combo box, select the scale where the unattended 
driver terminal is located. 

3. Click the Connect button on the Badge Assignment screen to 
connect to the unattended driver terminal’s badge reader. The 
button’s label will change to Disconnect, allowing you to undo 
this step. 

4. Scan the badge at the unattended driver terminal’s badge 
reader to enter the badge number in the Badge ID field. 

5. Use the Table Selection and Field Selection combo boxes to 
link the badge to a database record, such as a Vehicle ID. 

6. Click the Save button to save the Badge ID record. 

 

5-14   (4/09) 



Chapter 5: Other OverDrive Unattended Tools 
Badge Assignment 

Badge Reader at a PC Serial Port 
1. Select the By PC Serial Port radio button. 

2. Click the … button to open the Serial Port Configuration 
window. 

 

 
 

3. Enter the serial port configuration settings for the badge reader: 

 Port Number: Select the serial communication port. 

 Baud Rate: Select the baud rate. 

 Data Bits: Select the number of data bits (5, 6, 7 or 8). 

 Stop Bits: Select the number of stop bits (1, 1.5, or 2). 

 Parity: Select the parity (None, Even, or Odd). 

4. Click the OK button to save the serial port settings or click the 
Cancel button to cancel any changes. 

5. Click the Connect button on the Badge Assignment screen to 
connect to the serial port’s badge reader. The button’s label will 
change to Disconnect, allowing you to undo this step. 

6. Scan the badge at the PC serial port’s badge reader to enter the 
badge number in the Badge ID field. 

7. Use the Table Selection and Field Selection combo boxes to 
link the badge to a database record, such as a Vehicle ID. 

8. Click the Save button to save the Badge ID record. 
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Capture 
Digital 
Signature 

The OverDrive unattended application can be configured to require a 
signature to complete a transaction. If a signature is required, the 
transaction will be placed on hold until the signature has been 
processed. You can use the Capture Digital Signature screen to 
capture a digital signature and link it to a weighing transaction. 
Select Capture Digital Signature in the Tools menu. 

 

 
 

When the final weighing of the transaction is completed, the 
application will either require the driver to sign inside the scale 
house or prompt the driver to choose between signing at the 
unattended terminal or inside the scale house. If the driver signs at 
an electronic signature pad connected to the terminal, there is no 
need to use this screen. If the driver is required to sign inside the 
scale house or chooses to sign inside the scale house, the terminal 
will issue a signature hold ticket and place the transaction on 
signature hold until the driver’s digital signature has been 
processed. 

Use the following procedure to process a digital signature from the 
Capture Digital Signature screen: 
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1. Type the ticket number for the transaction in the Ticket Number 
field. Then press the ENTER key or TAB key to retrieve the ticket 
information and display it in the screen’s data fields. 

2. Have the driver sign the electronic signature pad that is 
connected to the computer. 

3. Click the Process button to capture the digital signature and 
complete the transaction. The printer that is selected in the 
Printer combo box will print a ticket for the transaction. In order 
to print tickets, you must enable ticket printing in the OverDrive 
software application and select an outbound ticket on the 
Account or Presets screen. 

Clicking the Clear button before the signature is processed will clear 
the signature from the screen in case the driver needs to start over. 

You can use this screen to retrieve digital signatures that are stored 
in the database. Type a ticket number in the Ticket Number field, 
and then press the ENTER key or TAB key to retrieve the digital 
signature. 

 
 The Connect/Disconnect button is used to toggle the digital 

signature feature on and off. 

 The Reprint button prints a duplicate ticket for the current 
transaction. You can also use the Reprint button to print a 
duplicate ticket for a previous transaction that you have 
retrieved (but only if a ticket was printed when the signature 
was originally processed). 
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Capture 
Payment 

The OverDrive unattended application can be configured to require 
payment to complete a transaction. If payment is required, the 
transaction will be placed on hold until the payment has been 
processed. You can use the Capture Payment screen to process 
payments for transactions. The screen includes tabs for accepting 
payment by credit card, debit card, cash, or check. Select Capture 
Payment in the Tools menu. 
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Credit Card Tab 
Before you can use the OverDrive Credit Card Module to process 
payment by credit card, you must install PCCharge payment 
processing software and set up a merchant account for handling 
credit card payments. The actual credit card processing is done by 
PCCharge software, and you will need to use the PCCharge 
application to close each daily batch of transactions in order to 
receive payment. Refer to the PCCharge manual for information 
about how that application works. 

When the final weighing of a transaction is completed, the 
application can either require the driver to pay inside the scale 
house or prompt the driver to choose between paying at the 
unattended terminal or inside the scale house. If the driver pays at a 
credit card reader connected to the terminal, there is no need to use 
this screen. If the driver is required to pay inside the scale house or 
chooses to pay inside the scale house, the terminal will issue a hold 
ticket and place the transaction on hold until payment has been 
processed. 

Use the following procedure to process a credit card payment from 
the Credit Card tab on the Capture Payment screen: 

1. Type the ticket number for the transaction in the Ticket Number 
field. Then press the ENTER key or TAB key to retrieve the ticket 
information and display it in the screen’s data fields. The 
amount of the transaction will be displayed in the Amount field. 

2. Enter the credit card number using one of the following 
methods: 

 If a credit card reader is connected to the computer, swipe 
the driver’s credit card through the reader. The system will 
process the credit card payment and print a ticket to 
complete the procedure. 

 Type the credit card number in the Credit Card Number 
field and then press the TAB key to replace the number 
with XXXXXXXXXXXXXXXX for security purposes. To 
complete the procedure, continue with Steps 3 to 5. 

3. Type the expiration date for the credit card in the Expiration 
Date (MMYY) field. 

4. Type the verification number printed on the back of the credit 
card in the Card Verification Values field. 

5. Click the Process button to begin processing the credit card 
payment. The printer that is selected in the Printer combo box 
will print a ticket for the transaction. In order to print tickets, 
you must enable ticket printing in the OverDrive software 
application and select an outbound ticket on the Account or 
Presets screen. 
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The remaining credit card transaction and transaction response data 
fields will be filled in automatically. The status bar at the bottom of 
the screen will indicate the status of the credit card transaction. 
Clicking the Clear button before the payment is processed will clear 
the tab’s data fields in case information was entered incorrectly. 

 The Reprint button prints a duplicate ticket for the current 
transaction. A ticket will no longer be available to be reprinted 
after the next ticket has been processed or the screen has been 
closed. 

 

 
 

Debit Card Tab 
You can enter information about debit card payments on the Debit 
Card tab. Unlike the credit card tab, this tab is used only for entering 
information. The actual debit card payment must be processed with 

5-20   (4/09) 



Chapter 5: Other OverDrive Unattended Tools 
Capture Payment 

a card reader and PIN pad that are separate from the OverDrive 
application. Use the following procedure to enter information about 
debit card payments: 

1. Type the ticket number for the transaction in the Ticket Number 
field. Then press the ENTER key or TAB key to retrieve the ticket 
information and display it in the screen’s data fields. The 
amount of the transaction will be displayed in the Amount field. 

2. Type the driver’s license number in the Driver License Number 
field. 

3. Type the payment authorization number in the Authorization 
Number field. 

4. Click the Process button to save the payment information. The 
printer that is selected in the Printer combo box will print a 
ticket for the transaction. In order to print tickets, you must 
enable ticket printing in the OverDrive software application and 
select an outbound ticket on the Account or Presets screen. 

Clicking the Clear button before the payment is processed will clear 
the tab’s data fields in case information was entered incorrectly. 

 The Reprint button prints a duplicate ticket for the current 
transaction. A ticket will no longer be available to be reprinted 
after the next ticket has been processed or the screen has been 
closed. 
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Check Tab 
You can enter information about payments by check on the Check 
tab. This tab is used only for entering information; it does not 
process or verify checks. When a driver pays for a transaction with 
a check, use the following procedure to enter information about the 
payment: 

1. Type the ticket number for the transaction in the Ticket Number 
field. Then press the ENTER key or TAB key to retrieve the ticket 
information and display it in the screen’s data fields. The 
amount of the transaction will be displayed in the Amount field. 

2. Type the check number in the Check Number field. 

3. Type the driver’s license number in the Driver License Number 
field. 
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4. Type the payment authorization number in the Authorization 
Number field. 

5. Click the Process button to save the payment information. The 
printer that is selected in the Printer combo box will print a 
ticket for the transaction. In order to print tickets, you must 
enable ticket printing in the OverDrive software application and 
select an outbound ticket on the Account or Presets screen. 

Clicking the Clear button before the payment is processed will clear 
the tab’s data fields in case information was entered incorrectly. 

 The Reprint button prints a duplicate ticket for the current 
transaction. A ticket will no longer be available to be reprinted 
after the next ticket has been processed or the screen has been 
closed. 
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Cash Tab 
You can enter information about cash payments on the Cash tab. 
Use the following procedure to process payment by cash: 

1. Type the ticket number for the transaction in the Ticket Number 
field. Then press the ENTER key or TAB key to retrieve the ticket 
information and display it in the screen’s data fields. The 
amount of the transaction will be displayed in the Amount field. 

2. Type the amount of cash paid by the driver in the Amount 
Tendered field. The amount tendered must be greater than or 
equal to the amount due. 

3. Click the Process button to process the cash payment. The 
amount of change to be given to the driver will be displayed in 
the Change Due field. If a cash drawer is connected to the 
system, the drawer will open automatically. The printer that is 
selected in the Printer combo box will print a ticket for the 
transaction. In order to print tickets, you must enable ticket 
printing in the OverDrive software application and select an 
outbound ticket on the Account or Presets screen. 

Clicking the Clear button before the payment is processed will clear 
the tab’s data fields in case information was entered incorrectly. 

 The Reprint button prints a duplicate ticket for the current 
transaction. A ticket will no longer be available to be reprinted 
after the next ticket has been processed or the screen has been 
closed. 

 The Open button opens the cash drawer manually. 
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Open 
Transaction 
Browser 

The transaction browser lets you view a list of open transactions 
(two-pass and multi-pass transactions for which the final pass has 
not been completed). Select Open Transaction Browser in the Tools 
menu. 

 

 
 

The transaction browser lists each open transaction on a separate 
line. The system automatically updates the transaction browser 
every 6 seconds by searching the database for open transactions. 

To void an open transaction, select it in the table and then click the 
Void button. 

When Always on Top is enabled (a check mark is placed in the 
box), the transaction browser will be displayed on top of other 
screens that are open. 

The transaction browser includes filters that let you limit the open 
transactions that are displayed. Use the combo boxes in the table 
headings to select a filter that will display only the transactions that 
include a specific transaction number, Carrier ID, Vehicle ID, gross 
weight, Account ID, or Contract ID. 
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Payment 
Server 
Configuration 

In order to accept payment by credit card, you must set up a 
merchant account with a bank or other credit card processor and 
you must purchase and install PCCharge payment processing 
software. The Payment Server Configuration screen is used to set up 
communication between the OverDrive application and the 
PCCharge server. To open the screen, select Payment Server 
Configuration in the Tools menu. 

 

 
 

Each OverDrive software installation that will process credit card 
transactions must have a unique User ID. If you install OverDrive 
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software on several computers and plan to process credit card 
transactions from them, you will need to purchase a PCCharge 
license for each computer. Refer to the PCCharge manual for 
information about supporting multiple users. 

1. Type the name of the computer (on which PCCharge is 
installed) in the Computer Name field. 

2. Type the number of the communication port in the Port field. 

3. Type the user name for the PCCharge server in the User field. 

4. Type the timeout period in the Timeout(sec) field. This is the 
number of seconds that the system will continue trying to make 
a dial-up connection. If a connection is not made within this 
time period, the system will display an error message and stop 
trying to connect. A timeout of 90 seconds is recommended. 

5. Check the boxes to indicate which types of credit cards will be 
accepted (American Express, Discover, Master Card, Visa). 

6. Click the Add button to open the Configure Merchant window 
so that you can add a new merchant and configure it. A 
merchant is a company that accepts payment for card 
transactions. 

 To remove an existing merchant, highlight it in the 
Merchants table and click the Remove button. 

 To edit the configuration for an existing merchant, 
highlight it in the Merchants table and click the Configure 
button. 

 

 
 

7. Check the Default Merchant box if you want this merchant to 
be the default merchant. The default merchant is the merchant 
that will always be selected for unattended credit card 
transactions. When credit card transactions are processed by a 
scale operator, another merchant can be selected manually. 
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The first merchant that you configure will automatically be the 
default merchant. If you configure additional merchants, you 
can designate one of them as the default. There can be only 
one default merchant at a time, so when you select a new 
merchant as the default, the first merchant will automatically be 
deselected as the default. 

8. Type the merchant number (which is supplied by the bank that 
handles the credit card account) in the Merchant Number field. 

9. Select the account type (credit card is selected by default). 

10. In the Processor field, type an identifier for the payment 
processer that was set up in PCCharge software. 

11. Click the OK button to save the merchant record and return to 
the Payment Server Configuration screen. 

12. After you have configured the merchant(s), click the OK button 
on the Payment Server Configuration screen to save the 
configuration changes. 
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Resource 
Editor 

The resource editor lets you edit resource files that determine what 
text and error messages appear on screen. It provides a convenient 
way to edit the files from within the application. To open the 
resource editor, select Resource Editor from the Tools menu on the 
main OverDrive screen or the Scale Configuration screen. 

 

 
 

Use the following procedure to edit a resource file: 

1. Open the File menu and click on the Open menu option. That 
opens a window from which you can select a resource file to 
edit. 
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2. Select the file that you want to edit, and then click the Open 
button (or double-click on a file name to open it). 

3. Each line of text is represented by a title (in the left-hand 
column) and the text that appears on screen (in the right hand 
column). The titles cannot be edited. Place the cursor in the 
line of text that you want to edit and type the changes. 

4. When you have finished editing the resource file, use the Save 
command in the File menu to save the changes or use the 
Save As command to save the edited file with a new file name. 
The Save As command can be used for creating a back-up or 
temporary copy of a file. Use the Send button to view changes 
on the unattended driver terminal’s display. Use the Exit 
command to close the file without saving the changes. 
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Video Server 
The video server is an optional module designed to control cameras 
that monitor activity at a scale and to store the digital images 
captured by the cameras. The Video Server Configuration screen lets 
you configure the video server cameras and assign a location for 
storing the images. You can install more than one video port, each 
of which can support as many as four cameras. To open the screen, 
select Video Server Configuration in the Tools menu. 

 

 
 

Use the following procedure to configure the video server: 

1. Select the location where the images captured by the cameras 
will be saved: 

 Database - The database where OverDrive transaction 
information is stored. 

 
 Directory - Use the browse button to select a network 

directory. 

2. Click the Add button to open the Configure VPort screen so that 
you can add a new video port and configure it. 

 To remove an existing video port, highlight it in the VPort 
Settings table and click the Remove button. 

 To edit the configuration for an existing video port, 
highlight it in the VPort Settings table and click the 
Configure button. 
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3. Enable the video port and configure it: 

 Check the Enabled box. 

 Enter a name for the video port. 

 Enter the IP address for the video port. 

 Enter the user name and password that were assigned 
when you set up the VPort application software. 

4. Enable and configure each camera connected to the video port: 

 Check the Enabled box for the camera. 

 Enter a name for the camera. 

 Select the video quality for the camera (Medium, 
Standard, Good, Detailed, or Excellent). 

 Click the Events button to open the Camera Events screen. 
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5. On the Camera Events screen, check the boxes for the events 
that will trigger the camera to capture images. If you are using 
more than one camera at a scale, you might want to assign 
different events to each camera, depending on the positions of 
the cameras. After selecting the desired events for the camera, 
click the Close button to save the selections and return to the 
Configure VPort screen or click the Cancel button to return to 
the screen without saving the selections. 

6. After configuring each camera that is being used, click the 
Close button on the Configure VPort screen to save the 
selections and return to the Video Server Configuration screen. 

7. On the Video Server Configuration screen, click the Assign 
button to open the Assign Cameras screen. 
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8. Assign cameras to the scale(s) by using the drag-and-drop 
method. The video ports and cameras that have been 
configured will appear in the left-hand list box. The available 
scales and unassigned cameras for each scale will appear in 
the right-hand list box. To assign a camera, click on the 
camera’s name in the left-hand list box and drag it to one of 
the unassigned camera locations in the right-hand list box. 
When all cameras have been assigned, click the Close button. 

9. Click the OK button on the Video Server Configuration screen to 
save all configuration changes. 
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Video Server 
Images 

The video server automatically saves images for the events that 
were selected when each camera was configured. There are two 
database tables, one for images captured during weighing 
transactions and one for isolated images that are not linked to 
transactions. To view the transaction images, open the Data Setup 
menu, position the cursor over the Images option, and select 
Transaction Images. 

 

 
 

The side tree on the Transaction Images screen lists all transactions 
for which images were saved. Click on a transaction number in the 
side tree to display the images saved for the transaction. You can 
scroll through the transaction numbers listed in the side tree or use 
the push buttons on the tool bar to locate a transaction. 

Push Buttons 
Find 

 This button updates the list to include new transactions that were 
added while the screen was open. 

Delete 

 This button deletes all images for the transaction that is currently 
displayed. To delete an individual image, click on the image to 
highlight it and then press the DELETE key on the keyboard. Use the 
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SHIFT or CONTROL key to highlight more than one image so that 
you can delete them using the DELETE key. 

First 

 This button returns to the first transaction in the database. 

Previous 

 This button returns to the previous transaction in the database. 

Next 

 This button goes forward to the next transaction in the database. 

Last 

 This button goes forward to the last transaction in the database. 

Arrow 
 This button is for future use. 

Data Navigation Pane 
 This button closes the side tree. When the side tree is closed, a Data 

Navigation Pane appears at the left-hand side of the screen. Position 
the cursor over the Data Navigation Pane to open the side tree for as 
long as the cursor is held over it. If you click the button again, the 
side tree will remain open. 

 

Working with Images 
Double clicking on an image opens a window containing an 
enlarged version of the image. 

 

 
 

You can change the size of the enlarged image by clicking on the 
lower right-hand corner of the image and dragging it to the desired 
size. Click the Save button on the tool bar to save a copy of the 
image to another directory. 
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Transaction and Image Information Tabs 
The Transaction Information and Image Information tabs display 
information about the transaction and image that is selected. 
Highlight an image to fill in the Transaction Details and Image 
Details fields. 

 

 
 

Transaction Table 

Transaction 
Number: The transaction number. 

Transaction 
Status: This status of the transaction. 

Carrier ID: The identifier for the carrier. 

Vehicle ID: The identifier for the vehicle. 

Account ID: The identifier for the account. 

Start Date: The date and time the transaction was started. 

Complete Date: The date and time the transaction was completed. 

Transaction Details 

Product ID: The identifier for the product. 

Number: The weighing number for the image. 

Scale Name: The name assigned to the scale. 

Operator ID: The identifier for the scale operator. 
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Image Details 

Image ID: The identifier for the image. 

Camera Number: The camera that captured the image. 

VPort IP: The IP address for the video port. 

Image 
Date/Time : The date and time when the image was captured. 

Event Name: The event that prompted the image to be captured. 

Image Path: The storage location for the image. 

 

Isolated Images 
Depending on the camera events that you select, cameras might 
capture images that are not linked to a transaction or ticket number. 
For example, a camera might be set up to capture images of trucks 
that drive onto a scale and then drive off without processing a 
transaction. These isolated images are stored in a separate table. To 
view the isolated images, open the Data Setup menu, position the 
cursor over the Images option, and select Isolated Images. 

 

5-38   (4/09) 



Chapter 5: Other OverDrive Unattended Tools 
Video Server Images 

 
 

Navigate through the isolated images using the push buttons on the 
tool bar, which work the same way as those on the Transaction 
Images screen. You can enter a note for an image by typing it in the 
Notes column next to the image. 
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Using the 
Video Server 

After installing the video server and configuring the video ports, you 
can use the video server to view live video from the cameras at the 
scales and to save video or still images. To open the video server, 
click on the OverDrive video server icon. Then open the Tools menu 
and select Cameras to open the Configured Cameras screen. 

 

 
 

The scales that are equipped with cameras will be listed in the side 
tree. To view the activity at a scale, click in the scale name in the 
side tree. The screen will display the live video from each of the one 
to four cameras connected to the video port. The following data 
fields and push buttons are available for each camera: 

Data Fields 
Camera Name: The name that was assigned to the camera when 

the video port was configured. 

Quality: The video quality that was selected for the camera 
when the video port was configured. You can 
change the video quality by selecting a setting in 
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the combo box (Medium, Standard, Good, 
Detailed, or Excellent). 

Push Buttons 

 

Connect: Click this button to connect the camera. When the 
camera is connected (the button is active), it will 
provide live video and capture images. 

Disconnect: Click this button to disconnect the camera. When 
the camera is disconnected (the button is 
inactive), it will not provide live video or capture 
images. 

 

 
Capture: Click this button to capture a still image of the 

current activity at the scale. You will be prompted 
to save the image and select a location for it. 

 

Zoom: Click this button to zoom in on the image. A 
sliding scale will be displayed to let you adjust the 
zoom from 100% to 400%. 

Manual Record: Click this button to record video from the camera 
and save it to the video server’s installation 
directory. Click the button a second time to stop 
recording. 
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Virtual Scale 
The virtual scale indicator displays the current weight from each of 
the scales connected to the system. It allows the system operator to 
view the weight activity on all scales. You can reposition the 
indicator and use the Always on Top feature to ensure that it will be 
displayed on top of other screens that are open. To open the virtual 
scale indicator, click on Virtual Scale in the Tools menu. 

 

 
 

For each scale, the virtual scale indicator displays the scale name, 
the gross weight currently on the scale, a symbol (~) to indicate 
when the scale is in motion, and a symbol (>0<) to indicate that an 
empty scale is at zero. Asterisks (******) in the weight field indicate 
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that the load on the scale is under/over the allowable weight range. 
Status lights indicate whether the scale is connected (green) or 
disconnected (red). 

The menu bar at the top of the screen provides the following menus: 

 

 
 

File Menu 
• Exit: This item closes the virtual scale indicator. 

Tools Menu 
• Always on Top: When Always on Top is enabled (a check 

mark displayed next to it), the virtual scale indicator will be 
displayed on top of other screens that are open. 

• Monitor OUDT: This item opens the OUDT monitor, which lets 
you view activity on the unattended driver terminal’s display for 
the scale that is selected. The OUDT monitor is described 
below. 

Actions Menu 
• Start OUDT: This item starts communication with the 

unattended driver terminal(s) at the scale that is selected. 

• Stop OUDT: This item stops communication with the 
unattended driver terminal(s) at the scale that is selected. 

• Zero Scale: This item zeroes the scale that is selected. The 
scale must be empty (within the zero range set for the scale 
terminal). 

 

(4/09)   5-43 



METTLER TOLEDO OverDrive Unattended Software User’s Manual 
 
 

 

OUDT 
Monitor 

The OUDT monitor lets you monitor an unattended driver terminal’s 
display from the computer that was used to configure the terminal. 
You can open an OUDT monitor for each scale separately and leave 
them open to monitor activity for all terminals simultaneously. To 
open the monitor, select Monitor OUDT from the Tools menu on the 
Scale Configuration screen or the virtual scale indicator (you can 
also right click on a scale to open the menu. 

 

 
 

OUDT Display: This field shows the message that is currently 
displayed on the unattended driver terminal. It 
provides a live view of the driver’s navigation and 
data entry. 

Keyboard Output: This field shows the data that the driver enters 
using the unattended driver terminal’s keyboard. 
The data will not appear in the field until the driver 
selects the Enter command. 

Reader Output: This field shows the data that the driver enters 
using the unattended driver terminal’s badge 
reader. 
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Number of Passes: This field shows the number of passes that have 
been processed since the last time the 
application was started. Each time the 
application is shut down, the number will reset to 
zero. 

The message bar at the bottom of the monitor indicates the status of 
the unattended driver terminal, hardware connections, and I/O 
connections. A green check mark indicates that the hardware or I/O 
is connected; a red “x” indicates that it is disconnected. 

Tool Bar 
The tool bar provides push buttons for several frequently used 
commands. 

Start OUDT 

 This button starts communication with the unattended driver 
terminal(s) at the scale that is selected. 

Stop OUDT 

 This button stops communication with the unattended driver 
terminal(s) at the scale that is selected. 

View I/O Configuration Image 

 This button opens a screen showing a detailed description of the 
predefined I/O configuration for the scale. 

Operator Override 

 This button disables input from the unattended driver terminal and 
enables you to process transactions from the OUDT monitor. The 
unattended driver terminal automatically resumes control when the 
OUDT monitor is closed. Clicking the button a second time will also 
return control to the unattended driver terminal. 

NOTE: Operator override mode will automatically be used for a scale 
if you select “0” (zero) as the number of driver terminals for the 
scale on the Scale Configuration screen’s Hardware tab. 

Manual Override Outputs 

 This button overrides the system’s output commands so that you 
can control traffic lights and gates manually from the OUDT monitor. 

When inputs and outputs are enabled for a scale, they will be 
displayed on the OUDT monitor. Clicking on the Manual Override 
Outputs button overrides the system’s output commands, allowing 
you to control the traffic lights or gates manually. With the manual 
override enabled, click on the monitor’s on/off indicators to switch 
the devices on or off. Click on the Manual Override Outputs button 
again to resume automatic control of the outputs. 

The scale must be empty (below the pass minimum weight) in 
order for the button to switch off manual override. 
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Push Buttons 
The push buttons are used to send messages to the unattended 
driver terminal’s display. 

1. Click the Clear button to clear the prompt from the screen and 
enable the Send button. 

2. Place the cursor on the desired line and type a message. 

3. Click the Send button to display the message on the 
unattended driver terminal at the scale. 

4. Clicking the Clear button will delete the message. To send 
additional messages, repeat steps 2 and 3. 

5. When you are done communicating with the driver, click the 
Reset button to reset the terminal so that it displays the most 
recent prompt. 
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6   Processing Transactions 
 

 

Unattended 
OverDrive unattended driver terminals can be equipped with various 
types of badge readers and keyboards for drivers to enter data. How 
data is entered depends on the way that the individual terminal is 
set up, and what data needs to be entered depends on the 
unattended transaction type that is created using OverDrive software. 
The sample procedure described below is for a one-pass transaction 
that requires the driver to enter only vehicle, transaction type, 
account, and product data. 

1. Drive a vehicle onto the scale. When the system is ready, it will 
display the following message: Welcome to OverDrive. Present 
Badge or Press [Enter] to Begin. Use a badge or press the 
Enter key to begin the transaction. 

2. At the Please Select or Key-in Your Vehicle ID prompt, scroll 
down to select the desired Vehicle ID or use the keyboard to 
type it. Then press the Enter key. If a badge was used to 
identify the vehicle, this step might not be necessary. 

3. At the Please Select or Key-in Your Transaction Type prompt, 
scroll down to select the desired transaction type or use the 
keyboard to type it. Then press the Enter key. 

4. At the Please Select or Key-in Your Account ID prompt, scroll 
down to select the desired Account ID or use the keyboard to 
type it. Then press the Enter key. 

5. At the Please Select or Key-in Your Product ID prompt, scroll 
down to select the desired Product ID or use the keyboard to 
type it. Then press the Enter key. 

6. After the data has been entered, the system will display the 
following message: OverDrive has captured the required 
information for this pass. Press [Enter] to Accept or Press 
[Home] to Cancel. Press the appropriate key to complete the 
transaction. 

7. The system will display the following message to indicate that 
the transaction has been completed: Transaction is Complete. 
Please pull forward to exit scale. Thank You! 

For a two-pass transaction, press the Enter key in Step 6 to accept 
the data from the first pass. When the vehicle returns to the scale for 
a second weighing, enter the Vehicle ID and then complete the pass. 

The OverDrive unattended system can be set up to require a driver to 
pay or sign in order to complete a transaction. Depending on how 
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the system is set up, the terminal will prompt the driver to pay or 
sign inside (the scale house or office) or will let the driver choose 
between paying or signing inside and paying or signing outside (at 
a terminal equipped with a credit card reader or electronic signature 
pad). If the driver is paying or signing inside, the terminal will issue 
a hold ticket. 

 

 

Keyboards 
Standard QWERTY and numeric keyboards for OverDrive unattended 
driver terminals are shown below. The following pages explain the 
functions of any keys that carry out special commands. 

 

 
QWERTY Keyboard 

 

 
Numeric Keyboard 

 

 

Abort 

The abort key cancels the current transaction and requires the 
weight on the scale to go below the pass minimum weight before a 
new transaction can begin. 
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Help 

The help key sends a visual and audible message to the OverDrive 
unattended application. 

 

Shift 

Pressing the shift key and another key at the same time gives the 
other key a second function. 

 

Short Codes 

The short codes key activates the OverDrive application’s short code 
function. 

Home 

 The home key cancels the current data selections and resets the 
unattended driver terminal to the prompt that is displayed at the 
beginning of a transaction. This command does not require the 
weight on the scale to go below the pass minimum weight. 

 
Item Selection Up 

The up arrow key selects the item above the current selection. 

 

 

Item Selection Down 

The down arrow key selects the item below the current selection. 

 

 

Page Up 

The double up arrow key displays the previous four data items. 

 

 

Page Down 

The double down arrow key displays the next four data items. 

 

Search 

 The search key activates the OverDrive application’s search function. 

 

Back Space 

 The back space key deletes the last character that was entered. 

 

 

 

 

 

Enter 

The enter key accepts the data that is currently selected. 

 

 

Space 

The space key enters a space in the text on the display. 
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